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What’s new in CAD Decor 3.0 
 

 
 

TECHNICAL DOCUMENTATION 
 

One of the most awaited changes in CAD Decor in version 3.0 is access to the professional, personalized and 
comprehensive technical documentation. The Documentation module in the CAD Decor 3.0 program can 

be launched in the visualization - after selecting the "Documentation" icon in the top menu. 
 
The documentation may contain any number and types of pages (including examples of visualizations, technical 
drawings, sections of selected walls or fragments of the design, drawings of worktops, floor sections and room 
sections with or without equipment). Some of these elements are selected during the initial configuration of the 
documentation or during further work with it, while the sections and wall projections can be created individually 

when the documentation is already generated. All pages of the documentation can be edited and freely 
adapted to your current needs. 
 
An interesting feature of our documentation is the possibility of displaying textures of objects (i.e. pieces of 
equipment, cabinets and worktops, tiles and paints). Of course, objects can also be presented in a linear form. The 

module also offers the ability to insert new objects directly in the documentation (various shapes, 

hatches, dimensions, texts and references, tables and images), as well as easy management of the scale and size of 
the sheet, separately for each page. 
 

It is worth mentioning that the new documentation supports much larger designs than the previously 

used module. 
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NEW VISUALIZATION LOOK (WITHOUT RENDER PRO) 
 

The visualization interface has changed. It is now more transparent and readable. 
Instead of three toolbars (the top menu icon, the panel with tabs "Materials", 
"Scene" and "Render" and the bottom bar with tile previews and tile functions), 
there are now four function groups. Their visibility can be easily and conveniently 
controlled (you can hide them, expand or narrowed them using the mouse or 
restore the default settings). We describe them below. 

 

The top menu has remained almost unchanged - with two exceptions: 
▪ the "Documentation" icon has been added; 
▪ another new icon "Quick save" allows to save images (standard, stereoscopic 

or anaglyph) and 3DE Presentations on the disk without selecting the location, 
format or resolution of files (because they are being saved accordingly to the 
last settings made in the "Save visualization" dialog box, opened by the 
"Export 3D scenes" icon. 

 

There are five new tabs available now in the left panel:  
▪ "Materials"– here you will find: a Paint Module (giving access to the Tikkurila’s 

and Sigma Coatings’ product offers), a list of  texture and material databases 
by various manufacturers as well as the library of universal (standard) testure 
databasres by CAD Projekt K&A with the ability of uploading any numer of 
user’s own textures; 

▪ "Tiles" – a list of databases for wall and floor linings and decorations from 
renowned manufacturers; 

▪ "Lights" – a list of light sources in the design: halogens, fluorescent lamps, 
point light and sunlight as well as luminous objects, i.e. emitters (objects 
attributed with a property of a real light emission – available only with Render 
PRO) and glowing objects (attributed with a property of glow, which is  
a simulation of an intense glare); 

▪ "Render" – rendering options and photographic filters; in the Render PRO 
module there are Radiosity and Ray tracing algorithms available, as well as a 

completely new Path tracing GI calculation method;  

▪ "Presentation" – a panel for recording AVI videos (in 2D or 3D), offering users 

of the additional Render PRO module also the ability to record 360o 
animations (videos recorded in a Spherical panorama mode to be posted 

on Facebook, requiring prior Path tracing calculations) and creating VR 
presentations, displayed by our VR file browser: obserReR (requiring prior 
Radiosity calculations).  

 

A totally new right panel has appeared, which includes editing functions: 
▪ after selecting a material (marking an object), its parameters can be changed - 

in the "Material properties" tab; 
▪ after left-clicking on the light source on the list in the left side menu, you can 

manage its parameters in the "Light properties" panel; 
▪ there is one more tab here: "Scene settings", in which you can control the 

camera and scene settings, and also save a list of selected design views in 
various resolutions to be used during rendering (while using the Path tracing 
algorithm, available in the Render PRO module, you can choose any number 
of these views to be rendered and obtain illustrations with various resolutions 
and camera settings, spending the time needed to perform calculations on 
other activities). 
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The bottom menu: 
▪ it displays previews of tiles and the functions of their application and edition, as well as a summary of the used 

linings (as in the earlier versions of the CAD Decor program); 
▪ also previews of materials from the currently selected collection of textures are presented here (analogously to 

the previews of tiles), what improved their visibility (they can be easily managed f. e. by changing their sizes, and 
after pointing the cursor on the item on the list, its enlarged preview will appear in the bottom left corner of the 
scene viewer)(previously the miniatures of textures were displayed in the much smaller left panel); 

▪ users of the additional Render PRO module after switching to the "Render" tab in the left side menu will see 
saved images and a preview of Path tracing calculations in the bottom bar. 

 

Visibility of the four groups of functions, described above, can be easily and conveniently controlled - after right-
clicking on the top bar, a small context-menu will open in which you can hide side and bottom panels or restore 
their default view. These three panels can also be expanded and narrowed using the mouse. 
 

 

NEW WAYS OF MANAGING MATERIALS 
 

CAD Decor in version 3.0 offers easy application of textures and colours already used in the scene to other objects, 
without time-consuming browsing of databases in a tedious search for a particular texture or looking for an identical 

shade on the palette. Thanks to the "Eyedropper" and "Bucket" tools for sampling and applying 
materials, the appearance of all elements of your design can be unified in a few moments! 

 
"Eyedropper tool" allows to lift (sample) a texture or colour from the indicated 
pixels along with previously attributed properties! The lifted material can be 
edited in the right panel or immediately used in the scene. Its’ properties, such 
as gloss, transparency, reflections, roughness, emission, glow or bump 
mapping, are automatically assigned to objects on which the sampled material 
is applied. "Bucket tool - applying materials to objects" and "Bucket tool - 
applying materials to layers" allows you to apply sampled texture or colour to 
other objects or surfaces (individually or to all objects assigned to a particular 
layer at  the same time). 

 

After selecting an object you can edit its properties in the right 
side menu. A new feature is the ability to edit surfaces (i.e. walls, platforms) 

for which no texture has been applied yet. You can move the texture, rotate it 
or change its size... You can attribute textures with such parameters as: gloss, 
transparency, reflections (general or planar: vertical or horizontal), roughness 
(which is vital for the natural appearance of light reflected by various surfaces, 
such as ceramic tiles, wooden worktops or floors), as well as light emission and 
glow (i.e. imitation of the intense light, which, however, does not affect the 
lighting distribution in the scene) and the bump mapping effect. 
 

It is also possible to manage a particular layer of an edited object 

(i.e. one that is difficult to indicate with the mouse, because other layer covers 
it) - the list of layers is available at the bottom of the right side menu. You can 
control their smoothing (the level of smoothness of rounded surfaces) and 
visibility or define whether the material should be two-sided to improve the 

distribution of light in the scene (this may be especially useful in case of some 
window blinds or other models made of single surfaces). 
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NEW WAYS OF MANAGING LIGHT 
 

▪ Lists of light sources on a separate "Lights" tab in the left side menu – 

for greater convenience and clarity! 

▪ Easier management of light sources - the ability to create groups 

of lights with any name. 
▪ Easy transfer of lights between groups using the "drag-and-drop" 

method or function available under the right mouse button. 
▪ You select light sources on the list in the left menu and modify their 

properties in the right menu. 

▪ Quick preview and edition of luminous objects, that is, objects 

and surfaces with attributed emission (emitting real light to the 
environment) and glow (imitating intense glow, but not having any 
influence on the light distribution in the scene). 

 
 

 
 
 

OTHER CHANGES IN VISUALIZATION 
 (WITHOUT RENDER PRO) 

 

▪ scene settings: "Statistics", "Diagnostics" and light distribution data: 
"Style" (IES selection for halogen lights) have been moved from left 
side menu to right one. 

▪ the "Bump mapping" feature has disappeared from the list of 
rendering options - it is now available in the "Material properties" tab 
in the right side menu. 

▪ in the "Presentation" tab in the left side menu we have added the 
"Stereo picture" panel, enabling you to manage 3D video settings. 

▪ sliders for controlling material properties now have 
numeric values that can be edited using the right mouse button and 

entered from the keyboard. 
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NEW PATH TRACING ALGORITHM (WITH RENDER PRO) 
 

In the additional Render PRO module there are currently available two algorithms for calculating the 
global illumination in the scene: Radiosity, which has been already very well known to users of our 

programs, and a completely new Path tracing algorithm, which analyzes how much light reaches every 

single pixel in the scene (analyzing the paths of the rays). 
 

▪ Path tracing is more precise than Radiosity and can provide results 

indistinguishable from real photographs – it can use many graphics 
cards to render a single view; 

▪ in addition to calculating global illumination, Path tracing also analyzes 
reflections and refractions of rays (i.e. light distribution on metal and mirror 
elements or glass) in a similar way to the Ray tracing method, which is used 
to enhance the results of the Radiosity algorithm; 

▪ in the Path tracing option panel you can create 360° Presentations 
that can be published on Facebook (the "Spherical panorama" function); 

▪ during rendering using the Path tracing algorithm, the preview of the 
currently analyzed image is visible, as well as previews of completed 
renderings, stored on the disk in the indicated folder; 

▪ we introduced new photographic filters for Path tracing to help 

you find those, that reflect the character of your designs the most 
accurately (in the "Filters" tab); 

▪ the mechanism used by the Path tracing algorithm allows to 
handle bigger designs than the Radiosity algorithm and to modify 

materials parameters (f.i. gloss, reflections) during computations; 

▪ we have also provided many new colour tones for Path tracing, to 

make it even easier for you to choose the right filter that best reflects the 
character of the designed interior (the "Filters" tab is available for both 
Radiosity and Path tracing, but in case of Radiosity it contains less items). 

 
 

 

CHANGES IN RAY TRACING OPERATION (WITH RENDER PRO) 
 

The user no longer has to choose the quality level of Ray tracing, i.e. the number of samples to be processed per 
pixel, from one sample for one pixel (1x1) to sixteen samples (4x4), or even the number of analyzed reflections and 

refractions, because we set all these parameters at the maximum level by default for all users! 
 
 

 

We optimized this feature so you do not have to compromise the quality to 
keep the computation time short! It will speed up your work and ensure the 
best visual effects without your effort. In the past, rendering of large scenes 
at 4K resolution at 4x4 mode caused excessive memory usage, because some 
part of the Ray tracing calculation was carried out by the processor, and the 
rest by the graphics card. Now the whole process runs on the graphics card 

and there are 32 samples per pixel analysed by default! Also the 
number of reflections and refractions has been set to 20 for each 
user, while previously the limit was 10 reflections and 20 refractions. 

 
We wish you a pleasant work in the new CAD Decor v. 3.0 


